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1. What is TREEMAP?

TREEMAP is designed as a simple tool for visually comparing host and parasite
phylogenies: you can view the host and parasite trees, interactively create
reconstructions of the history of the host-parasite association, perform randomisation
tests of tree similarity, and (if you have branch length information such as might be
obtained from DNA sequence data) compare branch lengths in the two trees.

I should emphasise that TREEMAP is an experimental program for comparing host and
parasite trees. It started out as a test bed for my research, and is not a finished product.
It is offered free and on an “as-is” basis to anyone interested in host-parasite
cospeciation. It runs on Apple® Macintosh®'s and under Microsoft® Windows™.

1.1 Copyright notice

Copyright © 1995 Roderic D. M. Page.

Permission to use and distribute this software and its documentation for any purpose is
hereby granted without fee, provided the above copyright notice, author statement and
this permission notice appear in all copies of this software and related documentation.

THE SOFTWARE IS PROVIDED “AS-IS” AND WITHOUT WARRANTY OF ANY KIND,
EXPRESS, IMPLIED OR OTHERWISE, INCLUDING WITHOUT LIMITATION, ANY
WARRANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.

IN NO EVENT SHALL THE  AUTHOR, THE DEPARTMENT OF ZOOLOGY OR THE
UNIVERSITY OF OXFORD BE LIABLE FOR ANY SPECIAL, INCIDENTAL, INDIRECT OR
CONSEQUENTIAL DAMAGES OF ANY KIND, OR ANY DAMAGES WHATSOEVER
RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER OR NOT ADVISED OF
THE POSSIBILITY OF DAMAGE, AND ON ANY THEORY OF LIABILITY, ARISING OUT OF
OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.

1.2 Contacting the author

If you have bug reports, comments or suggestions, please contact me at this address:

Roderic D M Page
Division of Environmental and Evolutionary Biology
Institute of Biomedical and Life Sciences
University of Glasgow
Glasgow G12 8QQ
United Kingdom

email: rod.page@zoology.oxford.ac.uk
fax: +44 141 330 6993
tel: +44 141 330 5971



TREEMAP User's Guide 4

1.3 Acknowledgements

TREEMAP would not have been ported to the Macintosh without Eddie Holmes and
Paul Harvey lending me their PowerBooks. Andrew Rambaut offer advice on things
Macintosh. Writing the program was made easier by using ideas from the National
Center for Biotechnology's VIBRANT library written by Jonathon Kans. TREEMAP is
written in C++ and compiled with Microsoft Visual C++ 1.0 (Windows) and Symantec
C++ 6.1 (Macintosh).

2. Getting started

2.1 Obtaining TREEMAP

TREEMAP can be obtained by anonymous ftp from the server evolve.zps.ox.ac.uk in
the directory /packages/treemap. There are two files present in this directory:

♦ TreeMap.sea.hqx (Macintosh BinHexed self-extracting archive)

♦ TREEMAP.ZIP (zip compressed Windows version)

2.2 Requirements

TREEMAP requires either an Apple Macintosh running System 7.0 or later, or a PC
running Microsoft Windows 3.1 or later.

2.3 Differences between Macintosh and Windows versions

I've tried to make the two versions as similar as possible; for example the data file
formats are identical, as are the menus, and most key commands. However, some
compromises have had to be made in order be able to develop the software on both
Mac's and PC's at a reasonable speed. Hence some parts of the interface are incomplete
and rather clumsy, but I hope to fix this eventually.

In this manual the following symbols indicate comments specific to one or other
version of the program:

Apple Macintosh

Microsoft Windows
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2.4 Installing TREEMAP

The Macintosh version of TreeMap is stored on the “Harvey group” ftp server as a
BinHexed file. Unless your ftp software automatically decodes BinHex files (as does
Fetch, for example) you will need to use BinHex 4.0 to obtain the self-extracting
archive TreeMap.sea. The latter will automatically extract the TREEMAP application
and supporting files.

To install TREEMAP, uncompress the TREEMAP.ZIP file using a program such as
XTree for Windows, WinZip, unzip, or PKUnzip, then copy the files into a directory
on your hard disk. The file TREEMAP.EXE contains the program, the remaining files
are support files and example data files. You can add TREEMAP to the Program
manager, or if you prefer, simply launch it from the File Manager or a similar program
(see your Windows documentation for details).

2.5 Background Reading

The concept of tree mapping is discussed in Page (1994). The method implemented in
TREEMAP is described in detail in Page (1995) — I strongly recommend that you read
Page (1995) before using this program.

3. Overview of program

This section provides an overview of the program.

3.1 Starting TreeMap

Macintosh

You can start TreeMap by:

♦ Double-clicking on the TREEMAP icon.

♦ Double-clicking on a TREEMAP document.

♦ Dragging a TREEMAP document onto the TREEMAP application icon.

You can start TREEMAP by:

♦ Double clicking on the TREEMAP icon if you've add TREEMAP to Program
Manager (see your Windows documentation on how to do this).
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♦ Dragging a TREEMAP data file onto the TREEMAP.EXE file in File Manager or
other file management software (e.g. XTree for Windows).

3.2 Windows

TREEMAP has four main windows which display various views of your data. Windows
can be selected by clicking on them, or by using the Windows menu. The font used to
draw text in each window can be altered using the Style menu. The contents of each
window can be printed (File | Print), copied to the Clipboard (Edit | Copy), or saved
to disk as a picture (File | Save Graphics File) or text (File | Save Text File) file.
Note that pictures, whether copied to the Clipboard or saved to disk, are formatted to
fit on a complete page, they also have the same orientation as the current printer
settings. Hence, for some windows you may want to alter the page set-up of your
printer (File | Page setup) before creating a picture.

3.3 Tanglegram Window

The Tanglegram window displays the current host and parasite trees with parasites
connected to hosts by a coloured line:

You can alter the appearance of the trees by changing the font used to draw the labels
(using the commands on the Style menu), and by rotating descendants about their
ancestor, thus “untangling” the trees. To do this, click on the desired branch.

With some practice, you’ll quickly be able to obtain a pleasing display. Note that
you’re not actually altering the phylogenetic relationships specified by the trees, merely
how the trees are drawn.

If your trees have branch length information you can display the trees as “phylograms”
by choosing the View | Phylogram command. To ignore branch lengths choose View |
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Cladogram. You can also toggle on and off the numbering of the internal nodes of the
trees (View | Internal labels). These numbers are arbitrary and are used to keep track
of the internal nodes. To display branch lengths in host and parasite at the same scale
choose View | Same scale.

Choosing other trees

If you have more than one host or parasite tree, you can change the tree you're looking
at using the popup menus in the Tanglegram window. These list the names of the trees
listed in the input file. Because the same trees are being compared in all windows,
changing a tree in the Tanglegram window also changes the tree in the Reconstruction
window and the Branch lengths window.

3.4 Reconstruction Window

The Reconstruction window displays the parasite tree (in black) overlaid on the host
tree (in light grey). This window is the core of TREEMAP, as it is here that you can
experiment with different reconstructions, find optimal reconstructions, and perform
various randomisation tests.

Creating a reconstruction

By default, TREEMAP reconciles the parasite and hosts trees, however unlike
COMPONENT, TREEMAP superimposes the parasite tree on the host tree (cf. Page,
1994: fig. 2c), rather than displaying the reconciled tree itself.

The parasite tree is drawn in black slightly below the host tree (drawn in grey), with
each node in the parasite tree draw below the corresponding node in the host tree. You
may want to alter the font to improve the display.

Interpreting the reconstruction

Reconstructions can be best explained using an example. The file SIMPLE.NEX
contains two small trees:

a

b

c

I

II

III

Fig. 1 Host and parasite trees from the file SIMPLE.NEX.
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As you can see they are incongruent. Go to the Reconstruction window to see the
reconciled tree:

a

b

c
III

4

I

II

host

sorting events

parasites

host

sorting event

parasites

duplication

cospeciation

Fig. 2 Reconciled tree for the host and parasite trees in Fig. 1. This tree has one cospeciation event,
one duplication event, and three sorting events

Reconciled trees are discussed in detail in Page (1994). In the figure above, the two
internal nodes on the parasite tree comprise a cospeciation event (l) and a duplication
(n).  Along the bottom of the Reconstruction window the status line appears showing
the statistics for this reconstruction.

Sorting events occur when parasites go extinct, or are differentially sorted
amongst hosts. For example, two sorting events occurred when host 4 speciated into b
and c. Given that host 4 harbours two parasites, we might have expected each to
speciate, so that hosts b and c each had two parasites. Either this did not happen
(hence parasite II was passed on to host b, and parasite III was passed onto host c) or
there was speciation, but only one descendant of each event survived.  The other
sorting event is associated with the duplication event at the base of the parasite tree.
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Host switching

The reconciled tree prohibits association by colonisation, that is, it prohibits host
switching. Let’s suppose that parasite “I” is associated with its host “a” by
colonisation, not by descent. To see what that reconstruction looks like simply click on
the parasite's name (“I”). You should now see a new reconstruction:

a

b

c

5

III

I

II

Fig. 3 A reconstruction with one instance of host switching (the line marked with the arrow A)

This reconstruction also has one instance of cospeciation, but no duplications or
sorting events. By clicking on “I” again you revert to the reconciled tree. Now try
clicking on “II”:

a

b

c

5

III

I

II

Fig. 4 An alternative reconstruction
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This reconstruction also has one cospeciation and one host-switch, but in addition it
has a single sorting event (on parasite lineage III where host 4 speciates into b and c).

Prohibited host switches

Note that TREEMAP will not allow some host-switches. Specifically it requires that:

♦ the ancestral host for all parasites be defined, and

♦ all host switches are between contemporaneous hosts.

The first requirement means that the root of the parasite tree and its two immediate
descendants cannot disperse. The second requirement prohibits spurious dispersals
such as from a host onto an ancestor of that host, which by definition no longer exists.
These requirements are discussed in Page (in press).

Host-switches need not be restricted to terminal taxa. In larger phylogenies you can
click on the internal nodes to create ancestral host-switching events.

3.5 Histogram Window

The Histogram window displays histograms obtained when you perform randomisation
tests (see below). You have the option of viewing the histogram as a graphic or as a
text summary, by choosing the View | Graphic as text command.

Output

The histogram TREEMAP draws is rather unattractive. If you copy it to the Clipboard
you can paste it into a graphics program for editing.

You can use the File | Save as text file to create a text file containing a text summary
of the histogram.

3.6 Branch Lengths Window

If your host and parasite trees have branch lengths, TREEMAP displays a Branch
Lengths Window containing a bivariate plot of the lengths of the corresponding branch
lengths. It computes and displays the correlation coefficient between the branch
lengths in the two trees. Again, this plot will not win any prizes for graphic design. The
File | Save text file... command allows you to create a text file listing each data point
which can be imported into a spreadsheet or charting program to produce nicer
graphics.

Types of plot

The types of branch length plot available depend on the types of tree you have. If the
tips of the trees all line up then the trees are ultrametric (see below). Ultrametric trees



TREEMAP User's Guide 11

are produced by phylogeny programs that assume a molecular clock, such as KITSCH
and DNAMLK in PHYLIP. Additive trees need not have all tips line up, and hence do
not assume a molecular clock.

Additive trees Ultrametric trees

If the current host and parasite trees are not ultrametric trees then TREEMAP plots the
lengths of the copaths (see below) in the two trees. However, if you have ultrametric
trees then you have two options, plotting branch lengths (copaths) or plotting
coalescences times.

Copaths

copaths

Host Parasite

A copath is a path between successive cospeciation events, or between a terminal
taxon and its most recent ancestor that is also a cospeciation event; hence a copath
traces out equivalent paths in the host and parasite tree. In the Branch Lengths window
the data points are labelled with the number of the host and parasite nodes that are
most distant from the root. If either of these nodes is a terminal taxon, the data point is
labelled with the name of that taxon.

Coalescence times

The coalescence time is the time two lineages last had a common ancestor. On an
ultrametric tree this corresponds to the distance between the ancestral node and any
one of its descendants:

3

2

1
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In the tree above there are three coalescence events, hence three coalescence times (1-
3). Given ultrametric host and parasite trees, we can plot the coalescence time of each
pair of cospeciation nodes (Hafner and Page, in press). For example, given these two
ultrametric trees,

TREE =  gophers TREE =  licetalpoides

bottae

14

bursarius

hispidus

cavator

underwoodi

cherriei

heterodus

9

10

11

12

13

15

wardi

minor

18

thomomyus

actuosi

ewingi

11

16

chapini

panamensis

setzeri

13

cherriei

costaricensis

12

14

15

17

19

Figure 5. Ultrametric trees for pocket gophers and their lice. Cospeciation nodes are numbered in
bold

the coalescence plot looks like this:

0

0.2

0.4

0.6

0.8

1

0 0.2 0.4 0.6 0.8 1

Host

Parasite

9-12

11-13
14-18

12-15

13-17

15-19

Figure 6. Plot of coalescence times (in units of genetic distance) for the cospeciation events in Fig. 5.
Each point is labelled with the numbers of the corresponding nodes in the host and parasite trees,
respectively. For example, the point 9-12 plots the coalescence time (measured in units of genetic
distance) for the parasite node 12 and its corresponding host node 9.

Because ultrametric trees are constrained to have all pairs of terminal taxa equidistant
from their most recent common ancestor these pairs are not independent; hence if you
have two ultrametric trees and request Plot branch lengths TREEMAP only plots the
lengths of the internal copaths.
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4 Managing Reconstructions

Having created one reconstruction you may want create others, but in doing so you'll
destroy the reconstruction you've just created. TREEMAP lets you save the current
reconstruction so you can recall it later. You can also start from scratch by clearing the
current reconstruction. The commands that manage the reconstructions are on the
Reconstruction menu.

4.1 Storing reconstructions

To save the current reconstruction choose the Store command from the
Reconstruction menu. A dialog box will appear: type in the name you want to give
your reconstruction (the name can have up to 31 characters) and click on OK.
TREEMAP will store the current reconstruction in memory.

4.2 Choosing reconstructions

To recall a reconstruction chose the desired reconstruction from the popup menu at
the top of the Reconstruction window. Choosing the reconstruction “none” clears the
current reconstruction.

4.3 Clearing the reconstruction

At any time you can clear the current reconstruction (that is, revert to the reconciled
tree) by choosing Clear from the Reconstruction menu. If the current reconstruction
has not been stored the program will ask you if you want to store it.

5 Finding the best reconstruction(s)

In this context the “best” reconstruction is defined as that with the greatest number of
cospeciation events (see Page, in press). TREEMAP offers two ways of finding the best,
a simple heuristic search and an exhaustive search.

5.1 Heuristic search

The heuristic search uses a simple algorithm that attempts to find a single optimal
reconstruction introducing successive host-switches until the number of  cospeciations
no longer increases. It is quick but is not guaranteed to find the best reconstruction
(although in practise it does rather well). Note that it finds only one reconstruction —
there may be others that are equally good, or better.

The heuristic algorithm is a useful way of quickly estimating the maximum number of
cospeciation events. It is also used by the randomisation tests described below.
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The reconstruction found by the program is not automatically stored, so if you want to
keep it you will have to store it using the Store command (see above).

5.2 Exact search

TREEMAP also features an exact algorithm that will find all the optimal
reconstructions. This algorithm is (a lot) slower than the heuristic method.

Be warned that if you use the exact search all currently stored reconstructions will be
lost as TREEMAP uses that storage space for the optimal reconstructions. Also, the
exact search can take a long time.  However, the program can sit in the background
allowing you to get on with other tasks (Windows version only).

Choose the Exact command from the Reconstruction menu. TREEMAP will display a
dialog box showing its progress. You can abandon the search by clicking on the
Cancel or Stop button.

Once the search is completed the optimal reconstructions are stored in memory and
can be accessed using the popup menu in the Reconstruction window (see above).

6. Randomisation tests

TREEMAP offers a range of randomisation tests (some more experimental than others)
designed to help evaluate the relationship between host and parasite phylogenies.

6.1 Is there evidence for cospeciation?

Given that the “best” reconstruction requires n cospeciation events, how do we know
if this is meaningful or not? One approach is to ask what are the chances of getting n
cospeciations by chance alone. TREEMAP allows you to randomise either the host or
the parasite tree, or both simultaneously. For each randomised tree (or pair of trees),
TREEMAP uses its heuristic algorithm to compute the maximum number of
cospeciation events between the two trees.

6.2 Generating random trees

You can choose to randomise either the host tree, the parasite tree, or both
simultaneously. Once you have chosen which option you desire, TREEMAP then
displays a dialog box asking you how many random trees you want to generate, under
which model they are generated, and how to seed the random number generator.

If you choose User value then TREEMAP uses the value you supply, otherwise
TREEMAP takes a seed from your computer's system clock.  If you supply a seed it
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must be in the range 1 to 2,147,483,646. If you use the same seed each time then the
same set of random trees will be generated.

The result of the randomisation test is a histogram of the frequency of the maximum
number of cospeciation events between the pairs of trees generated. This is displayed
in the Histogram window.

6.3 Comparing branch lengths

If your trees have branch lengths (e.g., amounts of sequence divergence) then you can
do one or more simple randomisation tests to assess the significance of the correlation
between branch lengths in the host and parasite trees.

Choose the Randomise | Branch lengths command. TREEMAP displays a dialog box
similar to the one for random trees:

Additive trees

If you have additive trees, TREEMAP will randomly reassign the observed branch
lengths in the parasite tree, then compute the correlation coefficient between the
randomised branch lengths and the observed host branch lengths.

Ultrametric trees (molecular clock)

If you have ultrametric host and parasite trees, you can either use a simple Yule model
to generate random coalescent times for the parasites, or randomise the
intervals between the observed coalescence times to generate new coalescence times
(this will be described in more detail elsewhere).

Results

As with the random trees, the Histogram Window displays the results of the
randomisation test.

7. Managing TREEMAP files

This section describes the file formats used by TREEMAP, and how you can create your
own data files.
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7.1 Kinds of files

On the Macintosh, TREEMAP creates three kinds of files: TREEMAP data files, PICT
files, and text files. These files have the following icons:

Data file PICT file text file

PICT files are standard Macintosh picture files, which can be edited by graphics
programs, or copied/pasted into a word processor. Text files are used to store text
output, and have their creator set to TeachText so you can quickly view their contents
using that program.

Under Windows, TREEMAP data files are standard ASCII text files with the default
extension *.NEX, and picture files are Windows metafiles (*.WMF). The later can be
read by virtually all Windows graphics programs and word processors.

7.2 Opening an existing data file

TREEMAP data files use a variant of the NEXUS format (the details of which are
presented later in this manual). To read a TREEMAP file choose the Open command
from the File menu. You will be presented with a standard File Open dialog box that
lists the available files. The program comes with several example data files for you to
examine.

TREEMAP also supports drag-and-drop opening of files.

Tree information

If your input file contains output comments you can view these using the Host
information and Parasite information commands on the View menu.

7..3 Creating a new TREEMAP file

If you have trees for the hosts and parasites (e.g., produced by a phylogenetic tree
building program such as PAUP or PHYLIP) then you can create a new TREEMAP file
using the File | New command. To do this you must have the following two files:

♦ Fully resolved, rooted trees for the hosts in either NEXUS (e.g. PAUP 3.0 or later,
MacClade 3.0) or PHYLIP format.

♦ Fully resolved, rooted trees for the parasites in either NEXUS or PHYLIP format.
Every parasite must have a host.
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The New command displays the following dialog box.

Fig. 7 The New Project dialog box.

To load your tree files click on the Get host tree(s)... and Get parasite tree(s)...
buttons. If the trees are successfully loaded the name of the file will be displayed to the
right of the corresponding button. Once you have both sets of trees you can click on
the Edit associations... button which displays the following dialog:

Fig. 8 Edit Associations dialog box.

The dialog displays a list of all host taxa, together with two lists of parasites: those that
are on the currently selected host, and those that are not. You can move parasites
between the two lists by double clicking on one or more parasite names.

Not every host taxa requires a parasite, but every parasite requires a host. Your
changes to the host-parasite associations will not be accepted unless this last
requirement is satisfied.

Once you've entered the host-parasite associations, click on OK and TREEMAP will
display the trees and associations.

7.4 Editing an existing TREEMAP file

You can edit the host-parasite associations using the Edit | Associations command.
This displays the same dialog box as described in the previous section.
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7.5 Importing and exporting COMPONENT 2.0 files

The file formats used by TREEMAP and COMPONENT (Page, 1993) are incompatible.
However, TREEMAP can read and write COMPONENT files. To read a
COMPONENT file choose Import from the File menu. A dialog box will appear
prompting you for the file name.

Should you wish to export a TREEMAP file for use by COMPONENT (for example, to
edit the trees or compute a reconciled tree) choose the Export command. Note that
any reconstructions you have created cannot be saved to COMPONENT files.

TREEMAP expects the COMPONENT file to contain a only single DISTRIBUTION
block describing the parasite's host distribution and relationships. Multiple
DISTRIBUTION blocks are not allowed.

An advantage of using COMPONENT files is that they can be easily created using
COMPONENT's text and tree editors. A disadvantage is that COMPONENT is
currently only available for Windows PC's.

7.6 Exporting files for Brooks Parsimony Analysis

Brooks parsimony analysis (BPA; Brooks and McLennan, 1991) is another method for
exploring the relationship between host and parasite phylogeny. It consists of coding
the parasite cladogram as a suite of binary characters which are then analysed using
parsimony. You can either use a tree building program to find the most parsimonious
host tree based on the parasite phylogeny, or you can optimise the coded parasite
phylogeny onto a known host phylogeny (similar to what TREEMAP does). Elsewhere
(Page, 1990; 1994) I have been critical of BPA; in particular I have argued that the
reconstructions it produces may be spurious. However, I have provided the facility to
export files for BPA so that you can explore this issue for yourself.

TREEMAP creates a NEXUS format file that can be read by PAUP 3.1 (Swofford,
1993) and MacClade 3.0 (Maddison and Maddison, 1992). The current parasite tree
displayed in the Tanglegram window is additive binary coded using “inclusive ORing”
(O'Grady and Deets, 1987), and the host tree (or trees) is written to a TREES block.
The binary characters are labelled with either the name of the corresponding terminal
parasite taxon or the number displayed when you choose View | Internal labels in the
Tanglegram window.

On the Macintosh the exported file has its creator set to 'CLAD' so that Finder displays
the MacClade icon (shown below). Double clicking on the file will load it into
MacClade.
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7.7 TREEMAP file format

TREEMAP uses a variant of the NEXUS format to describe the host and parasite trees,
the host-parasite associations, and the reconstructions. Extensions to the NEXUS
forma are currently being developed (David Maddison, pers. comm.) that will enable
me to replace the current format with a more portable format. In the meantime,
TREEMAP has its own file format. Here is a simple example:
a simple example:

 #nexus

 begin host;
tree host=(a,(b,c));

 endblock;

 begin parasite;
tree parasite =((I,II),III);

 endblock;

 begin distribution;
range

I : a;
II : b,
III : c
;

 endblock;

Each file must contain  HOST, PARASITE, and DISTRIBUTION blocks in that
order. The HOST and PARASITE blocks describe the host and parasite phylogenies.
You can either enter the trees directly (as above) or use the IMPORT command, e.g.

begin host;
import filetype=nexus

 file='\develop\cpwcpp\gophers.tre';
endblock;

This example imports a PAUP tree file called GOPHERS.TRE (you can also import
PHYLIP files).

The import command will only work if the file being imported is in the same folder as
the data file. The file= field should contain just the name of the file, without any path
information.

The file being imported can reside in any directory, and the file= command can contain
full path information.

Tree descriptions in the HOST and PARASITE blocks must contain the labels for the
host and parasite taxa; e.g., in the example given above, the host tree is described as
(a,(b,c)), not (1,(2,3)). If you are importing PAUP or PHYLIP files, TREEMAP

automatically obtains the labels from the imported tree file.
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TREEMAP requires binary (i.e., fully resolved) rooted trees for both the hosts and
parasites. Including non binary trees will cause the program to issue an error message
and stop reading your data file.

You can have up to 100 host and parasite trees, each with up to 100 taxa.

If you create one or more reconstructions the file saved by TREEMAP will contain a
RECONSTRUCTIONS block describing each reconstruction. Do not attempt to edit
this block.

7.8 Creating a data file from scratch

At present TREEMAP has no file editing facilities, so you will need to use a text editor.

Use a text editor such as TeachText or BBEdit.

Use a text editor such as Windows Notepad or the editor  provided by
COMPONENT.

If you use a word processor be sure to save your file as a text file.

7.9 Saving files

The Save command saves any modifications you have made to the original file. The
Save as command lets you save the trees (and any reconstructions) to a new file.
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